O Netbeans

O Netbeans é um ambiente integrado de desenvolvimento (IDE) que
permite ao programador criar programas utilizando recursos graficos.

Para trabalhar com o NetBeans é necessario ter instalado, anteriormente
em sua maquina uma das versfes do JDK (Java), preferencialmente uma versao

igual ou superior a J2SDK1.3.1.

Instalando o Netbeans

NetBeans, caso ndo tenha um CD de instalacao.

= ApGs o download, dé um duplo cligue no icone criado e siga 0s passos
mantendo os padrdes de instalacéo.

= Segue como exemplo algumas ilustragdes da instalacdo da versdo 3.5.1, a

versao 4.0 segue 0 mesmo padrao:

=T

Welcome to the InstallShield Wizard for NetBeans IDE 3.5.1

The InstallShield YWizard will install MetBeans IDE 3.5.1 on vour computer,
To continue, click Mext.

<7 Al o L. 1L ]

Installer

InstallShield

Mext= | Cancel



http://java.sun.com/

-iB/x]

Set the Install Profile.

Install Wizard will install new version of MetBeans IDE. If yvou choose, it will import
your |IDE settings.

|_ Impart Settings from:

[Neteens 0 35 ]
\@ “Elﬂa_ans NetBeans IDE 3.5

Instalier

InstallShield
= Back Mext = Cancel

L=

Click Mextto install "MetBeans IDE 3.5.1" to this directory, or click Browse to install to
a different directary.

Directory Mame:

|C:1.Arqui\ros de programasitetBeans IDE 3.5.1

Browse... |
netBeans

Installer

Installshield

NOTA: Antes de iniciar a constru¢cdo dos exemplos € interessante conhecer um

pouco da sintaxe basica da linguagem para facilitar o seu entendimento.




3. Conhecendo a IDE

- Depois de instalado, execute o NetBeans clicando no icone na area de

trabalho ou clicando no menu iniciar-> Programas—> NetBeans > NetBeans

- O mesmo devera exibir uma tela como a mostrada a seguir ou algo

parecido, isto vai depender do tipo da instalacdo/ SO/ Numero de vezes que o

mesmo ja tenha sido executado:

Opcoes de trabalho

|59 NetBeans IDE 3.5.1 - Source Editor [Welcome]

File Ecit “iews Project Build [Pebug ‘erzioning Toolz Window Help

Barrade Menu

=10l x|
o O [

‘po@®a| Xnewdc| e Bn) vpul
Explorer [Runtime] E
= z

Getting Started Using the IDE

% | 58 Runtime =

B e

= Open a file by double-clicking itz iconinthe
Filesystems tab of the Explarer.

x B &

Opening a File

Creating a File or Object

E&_ To creste & nesw file in the IDE, you mu

select atemplate for the type of |
to create. ;

[ ———— - If the file i=n't in the Filesystems tab, you must mount
=1 TARIS wilh Add EIUMN_ | =no Rraps it az filesystem to add it to your class path. To mount ® |n the Explorer, right-click  the di

Alter table with drop column | =no propel 7 filesystem: wou want to put the file in, and cho
AT 92 ertry level SEL =no propert type  fromthe Mesw submenu.

® |0 the main window |, choose File-=Mount ® Followy the wizard instructions. ¥
AME92 full level SEL =Nao propert Filesystem. /
ANS| A2 irtermediate level S =no propery ® | the Hew wizard |, =elect the Local Directory
Batch updates =No proper nodn_e. Then click pr)d'

® Havigate tothe directory vou want to mount —
Catalog at start =no propett |

4
Cataloy separator il | |
Welcome =

Catalog term il
Catalogs in DL =no propert [} Output Window [Compiler] E
Catalogs inindex defintions | =no propery
Catalags in privilege definition| =no propey -
Catalogs in procedure calls | =no propery z

Propetties

Compiler =
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3.1. Criando uma Aplicacao MDI:

|[Enetbeans 1. |{ DEP ML E 1143
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compilacdo



- Composta de:
1. Um Formulario principal
2. Um Menu

- Passos:

1° - Cligue no menu File-> New: sera exibida uma tela como esta:

MNetBeans IDE 3.5.1 - Source Editor [Welcome ] -0 x|
File Ecit Wiew Project Buid Debug Yersioning Took Window  Help 2 ¥ =
X
Steps Choose Template
1. Choose Template Select & Template:
" Templates
3 Folder

(3 Java Package
@ 0 Java Classes
G [0 Java GU Forms
@ [0 JavaBeans
& [0 JSPs & Serviets
Lo ol i
&= [0 JAR Archives
@ [  Ant Build Scripts
@ [ Cther

Template Description:

Containz all templates available in the IDE.

Each template lets waou create a new kind aof file.

| = Back || bl = H Finizh || Cancel H Help |
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2° - Dé um duplo clique em Java GUI Forms ou clique na respectiva Lupa:



3° - Selecione Sample Form -> MDI Aplication — com isto criaremos uma aplicacéo
composta de um formulario com um menu e que aceita a abertura de outros
formularios

4° - Clique no botdo NEXT:

Chooze Template

Select & Template:

JPamel Form
Bean Form
AT Forms
Sample Forms
Application
MO A pplication
Ok i Cancel Dislog
@ [ JavaBeans
G [ JSPs & Serviets

@ [0 xML
@ [ JAR Archives

o

@ @ =]

@
?

Template Description:

Uzing this template, you can design a JFrame application with pre-defined common menu tems and cor
JDesktopPane that internal frames may he added to at runtime.

Thiz template can be used as a main window for MDI applications.

5° - Dé um nome para o0 seu Aplicativo e no Campo Folder entre com um nome
que sera a pasta onde a aplicacao ficard armazenada - Package. Clique no botédo

Create > Next:



¥: NetBeans IDE 3.5.1 - Source Editor [Welcome]

=10l x|
File Edit “iew Project Build Debug “ersioning Toodlz ‘Window  Help n"l:. E
7 Mew Wizard - MDI Application x|
Steps Target Location
1. Choose Template Mame: |.£\.p|ica@§01 |
2. Target Location Target Location
3. Basic Cl Definiti I
e
' &= CE los-JavaiSist
5. Overrids Inherited Methads enpRsaasE Nome da
6  Cregte Methods @ = WEB-INFiclasses in nonexistert filesystem Aplicagéo
@ @ CExemploz-Java
@ [ agenda
& O sis
@ [0 sist
@ O Tutorisl
@ O teste
Nome da CriaaPasta
Pasta/Package
Folder: |Tut0rial| |
Directary: |C:1.Exemplns-Java1Tutnrial |
| = Back H Nexd = H Finish H Cancel H Help |
II'[L . !

| 1]
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6° - Sera mostrada uma tela informando o nome da Aplicacdo e o nome do

Package criado, a superclasse que sera extendida e as classes a serem

implementadas. Nao mude as op¢des padrao, cligue no botdo Next:



%% Mew Wizard - MDI Application

Steps

Choose Templste

Target Locstion

Basic Class Definition
Creste Figlds

Crverride Inherited Methods
Create Methods

o
T
Y

|_coor [ woar [| oon [| cocs [| b |

7° - Clique no botdo Next:



% New Wizard - MDI Application

Steps

Choose Template

Target Location

Basic Class Definition

Create Fields cuthienutem
Override Inherited Methods pasteMenultem
Create Methocs abouthienuitem
deletebenuitsm
conterthienutem
savelsMenutem
savehenuttem
helphdenu
menuBar

| coo [[ oo [] g || cmeo [[ e |

8° - Clique no botdo Next:
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2, Target Locsdion
3, Blsie Chicss Dafrdien Avpadably Superchus dnierace sihods: Wesnods To Be vamddan
8, Craae Fasds & fo Chass Obkec: [ e ]
6. (werride Inherited & f  claes Componant
Methods B B s Corlaner e J
B:  Crests Wetods B He clias Window =
= ol Frame e
o= Hy  class Froame s
@m0 inberinoe MeruContsiner = T
8= inberince mapsthosrver l 'n!'i'.""“m]
B mherinoe Senskzabi
8- +~3  mberince Ancessinks
Bl iberince fooFansConimnsr
- wlr nlarincs Windieeorerenls
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9° - Clique no botéo Finish:



|%¢ New Wizard - MDI Application x| I
Steps Create Methods ]
1.  Choose Template Add & method to the Methods list, then fill it in belove. Click an tem's ".." button for its customization. ]
2. Target Location -
3. Basic Class Defintion Methocs:

4. Create Fields 9@ intComponents() | [
3. Override Inherited Methods Ba  evitMenutemActionPerformedijava awt.evert ActionEvert)
6. Create Methods Ba  evitFormijava awt event WindowEvert)
@ main(String(])
Mame:
Return Type: thod Type
=dlefault=
Parameters (comma-separated): final el
J niative aynchronized
Exceptions (comma-separated): e
= Back | Finizh | | Cancel | | Help |

ialniciar”J & 4 = B |J #imagem | @Programasl ENetBea...
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A IDE abrird uma tela como a que se segue. O NetBeans trabalha com
varias mini-telas com finalidades especificas, todas de forma integradas a janela
principal, a barra de menu.

- Caso queira aumentar ou diminuir a area de visualizacdo de uma destas
basta passar o mouse e redimensiona-las de acordo com a necessidade do
programa.

- Para visualizar uma destas janelas clique no Menu View e selecione a

Janela desejada. Ex: Source Editor ou Form Editor

10° - Feche a Janela Explorer (File System) — clique no X, para aumentar a

area do formulario de Trabalho:

3.2 Componentes da Janela em modo de Trabalho



% NetBeans IDE 3.5.1 - Form Editor [Aplicacdol]

API / Comnonentes

=lol x|

File  Edit “iews Project Build Debug “ersioning  Toolz  Window  Help / ot o =
Band s &g Ssemade | g A b |iwyu
Arquivos / /
GUI Edliting / /
[7] Explorer [Filesystems] [=] B Form Aplicacgol / [«
[ Filesystems S Swing @5 Other Compone
@ @ C\Exemplos-Java b | - - @ Iﬁ [JFrame]
& 1 Agenda et [ B= e- 3T m B = [ }.: & Fe  menuBar [J
&= O sis - = - A = | BiorderLayn
@ [ Sist e
¢ ) File Edit Help W A
& B" 2picagiot B
53 teste W
Aluno
@ ¥ AreaCaixa barder (Mo Border)
" Cala faregraLn -
& Clock —
toolTipTest i
@ [B" ErtradaTeclado ooiiptest | nu
log ExJTextiresa
ExJTextires hat
& B ExlTextbreal | Properties
& [@" ExemploTr x -
[Folder W ’
[ Filesystems = B Aplicagéol =

[ output Window [Execution Yiew]

=

Command completed. No files needed to be created, changed,

Finished Project Sistena.

or deleted.

[

G

=Mo Processes Ru

Compiler *

||
0 Execution Yiew *

iﬂlniciarl“ 8 4 H)
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3.3 Compilando: Clique no Menu Build-> Compile ou Pressione F9

3.4 Executando: Clique no Menu Build - Execute ou Pressione F6

G SEHLMAE 2

Arquivos/

componete
do Projeto

Form de
Trabaho

Propriedade



MNetBeans IDE 3.5.1 - Form Editor [Aplicacaol *]

File Edt “iew Project

Debug  Yersioning Tools  Window  Help

X

|Execute (F6) |_

election=

baodel. javae

tad oz 17 de Agos

Clock

L—?;. =1 =Y [Br Compile FQ
B Compile 21 ShiftFg
Ul Editing
[Ep Build F11
Explarer [Filesystems
plorer [Flesy ] B Ewild A1 Shift-F41
[ Filesystems
P 32 CExemplos-Java [ clean
@ [0 Agends @ Clean 21
e [ sis
o 0 Sist Bt Stop Compile Alb+ShithC
= Tutarial B, hext Errar F1z
@ & Aplicagio
o O I%S’[e pleag B Previous Error  ShiftFi2
2 ., luna Set Arguments...
e An_eaCalxa B’ Execute F&
@'“' Caixa =
b Deploy

Tutorial;

B Form Aplicagi
@9 Other Cor
@ ﬁ [JFrame]

@@= [Fl. menu

E Biarde
&[] deskt

x Bl §

background

horder

fareground

toolTipText

Na execucédo da aplicacdo o formulario / janela abre exibindo apenas o menu, isto

porque ndo tem nenhum componente, verifique 0 menu sair, observe que o0

mesmo ja foi

implementado pelo NetBeans. Agora vamos

inserir alguns

componentes, procure deixar a sua aplicacdo parecida com a seguinte Tela no

modo formulario. (Lembre-se que € possivel alternar entre as telas de cédigo e

formulario clicando no menu View e selecione Form Editor/Source Editor):

Componentes Swina




% NetBeans IDE 3.5.1 - Form Editor [Aplicacdol]

=101 %]

File Ecit Wiew Project Buid Debug Yersioning Took  Window  Help = ¥ =
DeBOes | dDhoTOE|i0YiDE S PR d
U Editing

QﬁhhlEEﬂ_ﬁ_g:mEﬂEEDﬁmg

-

File Edit Help

@ 5 Other Companerts
Q ﬁ [JFrame]
@ [ menuBar [JWenuBar]
@ BorderLayout
Lo D desktopPane [JDesktiopPane]

B B e e

background

barder (Mo Border)

foregroune | |
toolTipText riull

B Aplicagao] =
E) Ot Windosy [Aplicaciot - N0 E
I:I =Mo Processes Ru

E@

4]

I

- Aplicacin] - o =

-L Execution Yiew * |_
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3.5 Trabalhando com componentes:

EE- T D

- Na janela no canto superior direito, que mostra os componentes da

aplicacédo, cligue o Bot&o direito do mouse sobre BorderLayout e selecione Set

Layout - AbsolutLayout

NOTA: - Esta mesma operacao pode ser efetuada clicando-se com o botéao direito

do mouse sobre a area do Formulario e selecionando SetLayout - AbsolutLayout.

- E necesséario modificar o Layout para que se possa colocar o0s

componentes (botbes, Labels, etc) na posicdo desejada, isto porque o Formuléario

(JFrame/Frame) quando é criado tem como padrdo o Layout BorderLayout que



trabalha de forma diferente. Mais a frente serd abordado de uma forma melhor

sobre os Layout.

E;ggaﬁ»@wﬁu

£ other Components

@ E [JFrame]

@ [Elx menuBar [JenuBar]

FlowwLayout

_| BiorclerLayout Goto Source . | —
Gridlayout
GricBaglayout
— CardLayaut

Propetties

— BoxLayout

Mull Layout

- Passe 0 mouse sobre os componentes da Aba Swing e observe que 0s

mesmos séo selecionados, cliqgue no correspondente ao JLabel e clique no
Formulario:

O o - e e e

(= o | B oR- oe- 2 m B = F OO B m Lf

JLabel
File Edit Help

- Na Janela Propriedades cliqgue em Text e insira o texto que deseja que
apareca no JLabel:



xBrw FE B e
foregrand ———

horizontalAlignment | LEADING

ican il
lahelFar =Mong=
text Formulétio
toolTipText null

- Insira outros componentes e mude suas propriedades realizando

experiéncias, compilando e executando, para visualizar os resultados.

Telas do NetBeans - Versao 4.0

e Tela de Inicializacao/Abertura

|58 NetBeans IDE 4.0 _=] x|

File Edit “iew Buld Run Refactor Yersioning Tools “Window Help

ELEO@ R BEBNCL,RBRE O DD

{Pr.40 X|J'i—'ifes _|'j'RurRi'i.;- | Welcame x]

&< netBeans D

| Hew Project | | Sample Project

;ﬂlniciar”J & ) ] BB || [E)Programas INetBeans IDE 4.0 KA [ E
e Criando uma Aplicagéo: - primeiro é necessario criar um projeto




 NetBeans IDE 4.0

File Edit  “iews Buil

IE' MNeww Praject,

By niew File...

F= ©pen Project. ..

Open File. ..

Cpen Recent Froject

Close Project

d Run Refactor
Chrl+Shif e+
Crrieh
ChrlH-Shife+0
Chrl+O

Wersioning  Tools

Window  Help

== =]

Set Main Projec

Prajeck Properti

t

[=3

Save

= Save Gl

Refresh Al Files

Ctrl+5

FPage Setup...
Brink. ..
Brink ko HTML, .

Chrl+P

Exit

|

@ @ W

b

—

&7 netBeans e 4o

| HNew Project

Criaum
Projeto

| | Sample Project

Biciar| | & 5 o B

J @Compact Disc (I @figuras-l‘detbea...l [

MNetBeans IDE...

H DeepBurner | | (BE- . ] %. 11:02

e Selecione General-> Java Application - Next

MetBeans IDE 4.0

=1 ]

File Edit “iew Buld Run Refactor Wersioning Tools Window Help
T = : I = = . nuh
4 E New Project |
- a
Prosl x| [Fies | cteps Choose Project =
(S5 Javasppli
@ 1. Choose Project Categories: Projecks:
E@ Sourc 5 —
D Eed £ Java Application
(-3 Test & Java Class Library
D samples @ Java Pro]:ect w?th Ex?st?ng
Java Project with Existing
Descripkion:
Select Java application ko create a skandard project containing an empty 328
also generate a main class in the project. A standard project uses the IDE-gq
build, run, and debug vour project.
| Cutput - = =
1| | »
= Back I Mext = I Finist I Cancel I Help I

Bmiciar ||| & 5 BB 7| Byoeva |

i MetBeans...

@imagem = oo |

<G AL, 123



Em “Project” digite 0 nome Desejado

MNew Java Application

Steps Mame and Location

1. Choose Project

Praoject Mame: IJava.ﬂppIicatiDnﬂ
2. Mame and Location

Project Location: IC:'I,ExempIu:us-Java

Praoject Folder: IC:'I,ExempIu:us-Java'l,Java.ﬁ.ppIicatiDn1

[+ Set as Main Project

[ Create Main Class  |javaapplicationl,Main

= Back | Mexk = | Finish I Cancel | Help

Criando um Programa: File> New File> Java GUI Form-> JFrame—> Next

| o
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File Edit Wiew Buld Run Refactor Versioning Tools ‘Window Help

D IE E . = | s . - ] Ir= = hooah

IProje... | IFiEs | Steps Choose File Type

% Runtime R .

: : oose File Type — —
[ serverre| 7 Praject: I@ Javaspplicationl

3 Processes
E = Database:
=3 Drivet

Categories: File Types:

Jawva Classes &T Japplet Form

3L Farms Ibialog Form
JavaBeans Objects ™1 Frame Form
ik JInternalFrame Form
I:| JPanel Form

24 XML Entity L Eean Form
Ant Build Scripts {7 JavaPackage
Cther
Descripkion:

Using this template, vou can design a new JFC (Swing) Applet.

An applet is a Java class that can be run in any Java-enabled browser.,

1| |
= Bach I Mext = I Finish I Cancel I Help

dl

Ealniciar”J a2 @ m ! > J |3 Compact ... I Figuras—Ne...l LlDeepBurnerI @imagem- | |<EE. .% 11:03
¢ Na nova janela que se abre digite 0 nome do Programa e clique no Botéo

Finish

JNetBeans...

e Insira os componentes desejados



{“f NetBeans IDE 4.0 - Javaapplicationl _|ﬁ||i|
File Edit Wiew Buld FRun Refactor Wersioning Tools ‘Window Help
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El‘a Javanpplication1 CENTES M | ,—Qg =t e [ Swing AT
G nbproject Layouts Eeans
Ela src et [ [ E5- 2 20 ﬂ
=3 javaspplicationl =B = M [ &

@Ingain.java

...@:H-‘]ixo.java Er ] EE 5] o = Ll
Labell
7 test
Z4 build.xml | Inzpestor o x|
B ™ [IFrame] ;I

D rmanifesk, mf

2 absoluteLayout
wwl jlabell [JLabel] -

| jLakel [JLakel] - Propertiesly > |

| Propetties Ewvetts

Code
=]
=1

laknelFar

toolTipText  null e

verticaltlign CEM... I
=] Other Properties
UiClassip  Labeln ]

alignment} 0.0 =]

text
ijawa.lang.Skring) Detines the

single line of text this component

ll |L| will display.

... B DespBurmer I e limagem - .. I |<ﬂ§- A 1109

J (3] Compact ... I @Figuras—Ne...l =

i@lniciarl“ &8 9 ) F

e Compile e Execute: Menu “Build”> Compile; Para executar Menu
‘Run”->Run Other



MNetBeans IDE 4.0 - JavaApplicationl

File Edit “iew Build

o B

Run Refactor  Versioning Tools  window Help

<> Run Main Project F&
o Debug Main Project: FS

=] x]

& & D D B

|Proje... | |Fila0 X || Run Other Test "Javadpplication1”  Alt+Fs | Palette » x|
Ela Sv:.n;plicatiu > attach Debuager ... e [ LSwin?: BAWT
L _ . ayouts 2ans
. ) Fimist Bebugger: Session Shift+FS Debug "lixe.java" Ctrl+Shife+FS ¥
M- nbproject et [ G @3- e— 2= -l
: Palise Tiest File Chrl+Fe o
B st ! == — e
= j ombinue i i
PoE a ]avaapFI Chrl+FS Debug Test For File Ctrl+shift+Fa 1 Iremeia o x|
3 B Main Step Gver F& - LIE AbsoluteLayout =]
. H- B lixa:; 5 Step Into = oot flabell [Jlabel] |
test p
D - Shep cut Alt+Shift+F7 JiLabel [ILakel] - Propertiedls = |
D manifest.mf P e Cursor F4 | Properties Events
i Code
Stack » dizplayedhin _;l
- — fort Microsoft SEJ‘_I
Togale Breakpoint Ctrl+Fa
i ki forearnund Il mom LI
Mew Ereakpoint. .. Ctrl+Shift+Fa jLabell [ILabel] )
! Mew Watch.., Ctrl+Shift+F7
-
L« | _'l_I
| Output 2 x|
Debugger Console = Javatpplicationl (run-single) = |
init: :I
deps-jar:
compile-single:
run—-single:
EUILD SUCCESSFUL (total time: Z1 seconds)| LI

DB Deepb... | Fjimage... | EE- [ Ve

J @Compa...l @Figuras...l EZlMetBe...

iﬁlniciar”J & Sl :ﬂ .m >

NOTA: Os exemplos que serdo apresentados foram implementados utilizando o
NetBeans 3.5.1, que se diferencia visualmente muito pouco em relacdo a versao
“4.0”, posto que serdo exemplos simples. Se for utilizar a versao “4.0” os passos a
serem executados sdo 0s mesmos, salvo excecao quanto a criagdo do Projeto que

ja foi demonstrado.



4. Aplicagbes Graficas com Swing

mAssunto: Aplicagbes Graficas com Swing

mObjetivo: criar aplicacbes Graficas utilizando Swing

AplicacBes Graficas com Swing

= Nova familia de componentes com funcionalidade ampliada e grande

capacidade de configuracao

= O seu propésito € permitir a criacdo de interfaces versateis e sofisticadas

= Surgiu em 1997 com a JFC ( Java Foundation Classes), com o Java 2, que

engloba:

o

o O O o

Componentes Swing

Compatibilidade com mdltiplas “Look and Feel" - “peles”
Biblioteca de acessibilidade — monitores e teclados especiais
Biblioteca Java 2D

Compatibilidade com "Drag and Drop’

Principais Componentes

File Edit “iew Project Build Debuy “ersioning Tools  Window  Help

peBda|Xinamoe| el

GLI Edliting

IEEI ﬂ@ﬁm—ﬁ—gimﬂgﬁmﬁmgmg

JLakel

|

= Os seus componentes sado semelhantes ao da AWT (Abstract Window

Toolkit), pois 0 modelo de eventos € 0 mesmo.




= Diferencas: Componentes Swing sdo mais flexiveis e mais numerosos

= Nao utilizam cédigo nativo, seus nomes iniciam com um J

» A base para uma aplicacéo € o JFrame ou JWindow ( janela) ou a classe
JApplet (miniapplicativos).

= JFrame nao é um mero container, mas um painel especial que agrega trés
outros componentes em camadas

= Destes 0 que nos interessa € o ContentPane (painel de conteudo), onde

vamos inserir os demais componentes:

Container conteudo= getContePane();

a) JLabel: rétulo de texto.

Métodos especificos:

String getText()= retorna o texto do label

void setText(String Ibl) = ajusta o texto do label para Ibl

b) JButton: € um bot&o simples que pode ser criado com ou sem rotulo.

Métodos especificos:

String getText()= retorna o label(etiqueta) do botao

void setText(String etiq) = ajusta label do botédo para o contetdo de etiq

c) JTexField e JTextArea

» TextField: caixa de entrada de texto, possibilita a entrada e a edicéo de
uma linha de texto.
» TextArea: caixa de entrada de texto com multiplas linhas. Exibe barra de

rolagem horizontal e vertical.



» principais métodos:

String getText()= retorna o texto contido no TextField

void setText(String txt) = ajusta o texto da TextField para txt

d) JList e JCombobox

= JList: caixa de lista que permite a exibicdo de uma lista de itens que néo

podem ser editados diretamente pelo usuario.

= JCombobox: implementa uma lista de itens em que um unico item
selecionado é exibido.

» principais métodos:

int getSelectedindex();= retorna indice do item selecionado
String getSelectedltem();= retorna o nome do item selecionado

void select(String str); = ajusta o item selecionado para str

- METODOS COMUNS A TODOS OS COMPONENTES

void resize(int width, int height) = Tamanho do componente

void move(int x, int y) = Mover componente

void setForeground(Color x) = Cor do componente

void setBackground(Color y) = Cor de Fundo do componente
void disable() = Desabilitando componente

void enable() = Habilitando componente



Gerenciadores de Layout

Gerenciamento de layout ( Layout Management ) € o processo de
determinar o tamanho e a posicdo dos componentes na janela gréfica do
programa, ou seja determinar onde os componentes ira ficar guiando a maneira
como os elementos de interface serdo dispostos dentro do container (Frame,
Panel,Window).

Existe basicamente os seguintes tipos de layout:

a) FlowLayout

b) BorderLayout
c) CardLayout

d) GridLayout

e) GridBagLayout

A escolha do gerenciador de layout depende muito das necessidades
do programa.

a) FlowLayout

Simplesmente posiciona os componentes da esquerda para a direita, criando
novas linhas se necessario.

EX:
=10 x|

b) BorderLayout

E o Padréo: Divide a janela em cinco areas nas quais 0s componentes

podem ser exibidos: norte, sul, leste, oeste e centro.



Fppiel Vierer: Bordar Bulfonliselef ol sss
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c) CardLayout

Permite apresentar dois ou mais componentes (geralmente painéis)
compartilhando o mesmo espaco de apresentacao. Funciona como uma pilha de
cartas onde apenas uma fica visivel.
- Cria-se um Painel fixo de Controle e um genérico (CardLayout) para conter

outros paineis

d) GridLayout
Deixa todos os componentes com igual tamanho, exibindo-os como uma
tabela (linhas e colunas).
EX: substitua a linha 9 do Programa Panel.java por:
setLayout( new GridLayout(3,1));
—iaix]

i Bution 3 E

e) GridBagLayout



E o mais flexivel dos gerenciadores de layout, permite colocar componentes
em grades de colunas, sendo possivel um componente ocupar mais de uma
coluna ao mesmo tempo. As linhas também né&o precisam necessariamente ter 0s
mesmos tamanhos, ou seja, vocé pode configurar diferentes larguras e alturas de

acordo com a necessidade. No entanto, € o mais dificil de ser implementado.



5. Aplicagdes Graficas com Swing — Construindo Aplicagcdes com o

NetBeans

= Assunto: AplicacBes Graficas com Swing — Construindo aplicacdes com o
NetBeans

» Objetivo: criar aplica¢des Graficas utilizando Swing

Utilizando JLabel, JTextField e JButton com o NetBeans

1. Crie uma aplicagéo para somar os valores de duas Notas Fiscais a serem

informados pelo usuario:

m  Nesta Aplicacdo utilizaremos dois JTextField (onde o usuario ira digitar os
valores) um JLabel (mostrar o resultado da soma) e um botdo a ser clicado
para efetuar a soma

m Abra o NetBeans - Clique no Menu File > New - D& um Duplo clique em

Java GUI Forms - Selecione JFrame Form - Clique no Botdo Next

|5 New Wizard

Steps Choose Template
1. Choose Template Select a Template:
2. . [ Fomer

0O JavaPackage
@ [ Java Clazses
@ 3 Java GUIForms
ﬁf JApplet Form
]| JDialog Form
JFrame Farm
JnternalFrame Form
JPanel Farm
Bean Form
AWT Forms
Sample Forms

[ Y

?9

m Na nova janela que se abre Digite “JCalculadora” - Clique no Boté&o Finish,

seu projeto sera iniciado




"F Mew Wizard - JFrame Form

Steps Target Location

1. Choosze Template Hame: |JCaIcuIadc:ra

2. Target Location Target Location

3. Basic Class Defintion _B Filesystems

4. Create Field

5 Or\feer:delTnhzrﬂed Methods e & CiExemplos-lava

o et @ = ClExemplos-Java | MED-INFiclasses

m Antes de inserir os componentes, devemos modificar o Layout para

AbsoluteLayout ou para NullLayout, para podemos criar 0 nosso Layout.

NOTA: - O AbsoluteLayout € um gerenciador de Layout criado especificamente
para o NetBeans, portanto se for utiliza-lo sem o NetBeans tera de acrescentar o
respectivo pacote e distribui-lo juntamente com o seu programa. Caso contrario o
mesmo nao executara corretamente.

- O Null Layout ndo é um gerenciador de Layout, mas corresponde a
situacdo em € desativado uso dos gerenciadores, neste caso a posicdo dos
componentes é explicitamente definida através de métodos especificos que a
ferramenta se encarrega de manipular, mas os mesmo nao vale para o Formulario
(Frame/JFrame), onde se faz necessario a utilizacdo do método setBounds:

Ex: setBounds(10,10,300,400);

/l abre o tela na posicao largura 10, altura 10, com um largura de 300 e altura 400.

m Na janela, no canto superior direito, Clique com o botéao direito do mouse sobre
“JFrame” - setLayout - clique em NullLayout

[%9 NetBeans IDE 3.5.1 - Form Editor [Component Inspector]

File Edit “iew Project Build Debuy ‘ersioning Tools Window Help

‘;ggma - = ‘;@;3@. T (- -4 ‘;é;QD‘;@; B % b H B fp 3 s
Ediiting | GLI Editing | Debugging |
Swing [ Swing (Other) [ AWT [ Beans | Layouts Elorders| B Form JCalculadora
o @ L Cther Components

W === 3ol H0FmdeES &= fiFrames
FloveLsyout Set Layout
BorderLayout
GridLayout Add From Palette

GridBaglayout

Design This Cord
CardLayout

Everts
BoxLayout

Abszolutel ayout

[l Layout
T Chanoe Order ..

Copy




m Na janela do Centro do video, embaixo da Aba “Swing”, existem varios icones
representando 0s respectivos componentes, passe 0 mouse sobre 0s mesmos
e aparecera o nome, clique no primeiro, “JLabel", e clique no Form, Clique no
segundo, “JButton”, e cligue no Form, Clique no nono, “JTextField”, e clique no
Form (dois JTextField), insira mais dois JLabel e outro JtextField.

m Na janela Propriedade modifique as propriedades dos componentes de acordo

com a tabela:
x 8w [E ®

background
font Abcde...
faregraun _
harizortalAlignmernt | LEADING
icon il
labelFor <Mong:=
text |Nllmer0 1|

Componente Propriedade Valor

JFrame Title Calculadora

JLabell Text Numero 1

JLabel2 Text NUamero 2

JLabel3 Text Resultado

JTextFieldl Text “

JtextField2 Text “u

JButton1 Text Somar

Nimero 1 ’—
Hiamero 2 ,7
Somar



m A parte visual ja foi criada precisamos implementar o cédigo no botdo para
efetuar a soma (“pegar” os niumeros e soma-los)

m Dé um Duplo clique no botdo e na janela de cédigo que aparece digite:

double numl1=Double.parseDouble(jTextField1l.getText()); // converte texto
para double

double num2=Double.parseDouble(jTextField2.getText());

double result = num1 + num2;

String R= String.valueOf(result); //Converte o Resultado para String
jLabel3.setText("Resultado: "+R); //exibe no JLabel o Resultado

= ApGs digitar os comandos o arquivo de codigo devera ficar da seguinte forma:

private woid JEuttonlifctionPerformed|java.awt . event. ActionEvent evt)
hnuble nunl=Louble. parselouble (jTextFiseldl getText () ; /7 cooverts texio pa:r
double nunZ=Double.parselouble(jTextFieldZ. getText ()}
double result = numl+tnum#;
Btring B= Btcring.walweDf (result); FiComvarte o Resultade perae Shrimg
jlabkeld. getText ( "BEesultado: "+R); Sexibe mo Jlabel o Resultedo
S0 Add your haepdlimg code e

= Observe que os nomes dos componentes (jLabel3) comegcam com letras
minusculas.

» Parte do Cddigo com a declaragdo dos componentes criados:

S Tariabkles declaration - de pot moedify
private javax.swing. JButton jButtonl;
private javax.swing. JLabel jLabell;
private javax.swing. JLabel jLabelz;
private javax.swing. JLabel jLabeld;
private javax.swing.JLabel jLabeld;
private javax.swing. JTextField jTextFieldl;
private javax.swing. JTextField jTextFieldEZ;

S End of variables declaradics

» A parte do Cadigo que estiver na cor azul ndo aceita modificagdes.



Se for utilizado o Layout AbsoluteLayout basta compilar e executar o programa
para o mesmo funcionar normalmente.

Mas, como o Layout que estd sendo utilizado é o Null Layout, quando o
programa for executado a janela aparecera mostrando apenas a barra de titulo.
Para a janela abrir e mostrar todos os componentes, devemos acrescentar o
comando com a localizacéo e tamanho da janela

(setBounds(posX,posY,Largura,Altura)), procure a seguinte linha de cédigo:

SHE Cregtes pew form JCalcouladorae */
public JCalculadorai) {
initComponent=1() ;

"

Ap6s initComponents(), insira 0 seguinte comando:

setBounds(10,10,300,400);

Apés o comando o arquivo de codigo ficara desta forma:

A Creates pew form Jhelouladorse *7F
public JCalculadoral) |
initComponent=1) ;
getBounds (50,50, 450, 300);

Se precisar voltar para o modo Form Editor clique no Menu View - Form
Editor ou “Crt+8”

Para ir para o cédigo cligue no menu View-> Source Editor ou “Crt+3”.
Compile Menu Build - Compile (F9), execute Menu Build > Execute (F5)

Criando uma Calculadora

Utilize o programa anterior e acrescente mais 4 (quatro) JButtons:

Componente |Propriedade |Valor Propriedade |Valor




JButton2 Text Diminuir |Mnemonic |D
JButton3 Text Multiplicar | Mnemonic  |M
JButton4 Text Dividir Mnemonic |V
JButton5 Text Limpar TooltipText |Limpar as caixas de Texto

= Dé um duplo cligue no botédo Diminuir e insira o seguinte cédigo:

double numl1=Double.parseDouble(jTextField1l.getText()); // converte texto

para double

double num2=Double.parseDouble(jTextField2.getText());

double result = num1- num2;

String R= String.valueOf(result);

/[Converte o Resultado para String

jLabel3.setText("Resultado: "+R); //exibe no JLabel o Resultado

» Repita 0 processo nos outros botbes modificando apenas a operacao

matematica.

= Dé um duplo clique no botéo “Limpar” e digite:

jTextFieldl.setText(" "); //limpa a caixa de texto

jTextField2.setText(" ");

jTextFieldl.requestFocus();

//muda o foco para a caixa 1

Nimero 1

Niumero 2

-

|

Somar

H Diminuir H Multiplicar H Dradir ‘

Resultado

= Compile (F9) e execute (F6).




Eggtalculadnra - 10| x|

Nimero 1 5.4
Limpar
Niimero 2 25

Somar H Diminuir || Multiplicar H |

Resultado: 0.45454...

» Para criar um arquivo que é executado diretamente pelo Windows basta criar

um arquivo “.Bat”:

e Abra o Bloco de Notas e digite: java JCalculadora
e Salve com um nome qualquer e com a extensdo “Calculadora.Bat”, na

mesma pasta do programa:

Salvar em: IaTrab j 4= I'j{ '

8] .nbattrs &l

@ Calculadora$l .class
a Calculadora$z, class
Calculadnra

@ Calculadora.class "'I't'l
a Calculadora,Form
E Calculadara. java

Calculadora

Mome do arquivo: IJEaIcuIadura.haﬂ j Salvar I
Salvar como tipo: ITndng 0% arquivos j Cancelar |

OBS: Lembre-se que o Layout “AbsoluteLayout” é EXCLUSIVO do NetBeans,
sendo que para utiliza-lo efetivamente na sua aplicagdo, vocé devera incluir no
seu projeto o respectivo pacote, sendo na execucao ocorrera erros, ou modifique o
Layout para “Null Layout” e defina o tamanho de seu Frame/JFrame para que o



mesmo possa ser visualizado no tamanho desejado (setBounds()), caso contrario

0 mesmo aparecera mostrando somente a barra de titulo.

OBS2: Para fins de agilizar a construcdo dos exemplos serd utilizado o Layout
“AbsoluteLayout”, mas se for construir comercialmente um programa, 0 mesmo

devera ter o Layout “Null Layout”.



6. Utilizando JCombobox/Jlist e JRadioButton

JCombobox/JList

a) Criar uma aplicacdo para informar qual a forma de pagamento selecionada

pelo usuario: Cheque, Cartdo ou Dinheiro:

cliqgue em Next

Na Janela que se abre digite FormaPaga - clique no botéo Finish

Modifique o Layout para AbsoluteLayout

Pagamento”

cliqgue em Model — clique no Botéo “...”.

Clique no Menu File > New - Java GUI Forms - clique em JFrame Form -

Cliqgue no Form e modifique a propriedade “Title” do Form para “Forma de

Clique no sétimo icone “JCombobox" e clique no Form, na Janela Propriedades

fSWing |/Swing (Other) r.lW\lT rBeanS rLaynuts |/Elnrder3| B Faorm FormaPaga

@ﬁ““"@@m_‘@_g:mmEEDﬁMQEE @E[JFrame]

@ 7 Cther Componerts

= jComboBox] [JCom

faregroundd

xlww B =

maximumREonwCount

GCII

mael

zelectediem

= Na janela que se abre em “Item” digite: cheque e clique no botdo “Add”, digite:

cartdo e cligue no botdo “Add”, digite dinheiro e clique no botdo “Add”, clique

no botdo “OK”

sslectedindex Invokes custami:

il




W5 model

- Select Mode: |ComboElanodelEd'rtor hd

1

u

them: |Car‘t§c-|

|‘ Al

ttem List

Cheqgue

Insira um JLabel: clique no primeiro icone (JLabel) e clique no Form.
Insira um JButton: clique no segundo icone (JButton) e clique no Form

Cheque - ‘ | Escolher

Dpcao:

A parte visual foi criada, falta o codigo. Para saber qual a opcéo selecionada

utilize o Método:

Object getSelectedltem().

Eciit

Remaove

Dé um duplo clique no botdo “Escolher”:

String S= (String) jComboBox1.getSelectedltem();//converte em String

jLabell.setText("A opcéao escolhida foi: " + S); /lexibe op¢éo no Jlabel

Compile (F9) e Execute (F6).

Se desejar também é possivel saber o indice: getSelectedIindex()
A utilizac&o do JList € idéntica a vista a cima, basta substituir o método

getSelectedltem(), por getSelectedValue().

== il




Utilizando JRadioButton com o NetBeans

b) Criar uma aplicagéo para mostrar o tipo de motor (1.0/1.6/2.0) escolhido pelo

usuario

= Crie uma nova Template JFrame Form “Motor”, clique no Menu File> New ...

= No Form que se abre Clique no sexto icone “ButtonGroup” e clique no Form
para criar um grupo de radio e permitir a selecdo de apenas uma opgéo

» Clique no quinto icone “JRadioButton" e cligue no Form, na janela
Propriedades selecione “Text” e digite “Motor 1.0”. Selecione a propriedade
“buttonGroup” e cliqgue em “buttonGroupl”, repita todo o processo por duas
vezes para criar a op¢ao “Motor 1.6” e “Motor 2.0”

= Insira um JLabel, Text: “Opc¢ao Escolhida”, no Form e um JButton, “Escolher”.

1.0 186 20

Opgao escolhida:

» Para saber qual a opcdo esta marcada devemos utilizar o Método boolean
isSelected(), que devolve true ou false.

= Dé um duplo cligue no botéo para inserir o codigo:

if jRadioButtonl.isSelected()) //verifica se a op¢ao esta marcada -true

jLabell.setText("Motor escolhido: 1.0"); //lexibe op¢éo no JLabel

if jRadioButton2.isSelected()) //verifica se a opcéo esta marcada -true
jLabell.setText("Motor escolhido: 1.6");

if jRadioButton3.isSelected()) //verifica se a opcao esta marcada -true
jLabell.setText("Motor escolhido: 2.0");



= Para saber qual € o Texto exibido pelo JRadioButton basta utilizar o Método:
String getText().
Ex: String s=jRadioButtonl.getText();

1o x|

i E%Esculher Motor

W 16 20

Escolher

Opcao escolhida:




7. Aplicacdes Graficas com Swing — Componentes Especializados

= Assunto: Aplicacbes Graficas com Swing — Componentes Especializados

= Objetivo: Criar aplicacfes utilizando componentes especializados Swing.

JOptionPane

» Janelas de dialogo para informar ou solicitar confirmacao de operagcdes ou
efetuar a entrada direta de valores:
sMensagens
= Entrada de Texto

m Janelas de Confirmacao

ﬁl
ﬁ Mensagem iy Mensancm
I |
| ok || cancol |

Eéfgielect an Dpkion |
|
E Confirmar?
0K | Cancel
Exemplos:
//IMensagem

JOptionPane.showMessageDialog( this, “mensagem?”);




/I Confirmacéo

int x = JOptionPane.showConfirmDialog( this, “Mensagem1”);

/l Entrada de Texto
String s= JOptionPane.showlInputDialog(“Mensagem 27);

int x = JOptionPane.showConfirmDialog(this, "Confirmar?“ , "Aplicacao”,
JOptionPane.OK_CANCEL_OPTION,
JOptionPane.QUESTION_MESSAGE);

m Nas IDE como NetBeans é possivel inserir um objeto visual, mas ndo é possivel

controlar as a¢des dos respectivos botdes.

m Se quiser utiliza-los no Netbeans, insira-os dentro de um método
actionPerformed de um JButton.

m Exemplo: - Criar um Programa contendo um botdo que ao ser pressionado

exiba informacgdes sobre o programa:

- Crie uma nova Template JFrame Form “Mensagem”, Menu File>New ...

- Mude o Layout para AbsoluteLayuot

- Insira um JButton “Mensagem”, dé um duplo clique para inserir o cédigo:

Mensagem

JOptionPane.showMessageDialog(this,"Programa criado \n utilizando o
Netbeans");

I/l 0 “\n” foi utilizado para mostrar como inserir uma quebra de linha.

- Este componente pertence ao pacote Swing que deve ser importado através do

“import”.



- Procure no cédigo o comando que cria a classe, que esta no inicio do programa:

public class Mensagem extends javax.swing.JFrame {

- Antes deste comando insira o codigo:

import javax.swing.*; /importa os componentes do pacote swing.

Swing [ Swing (Cther) [AWT [ Beans | Layouts | Borders B Form Mensagem
r |/ . r r | © ] Cther Components
powe = OE oe-e- 32w B = RO m=OdE B |@E|[u-1amsl
FloseLayout Set Layout
BorderLayout
GridLayout Add From Pale
GricBaglayout Design This Co
CardLayaut
Events
BoxLayout
C
Absolutelayout oL
Mull Layout
Mensagem H‘ Change Order
Ginbn Snree

- Compile e Execute.

|2 rensogem o x|

t

| Mensagem B B
x|

= = | P

2 ZE de Maprgo de 2 1 Programa criado

utilizando o Netheans

e Todos os exemplos anteriores poderiam ter utilizado o

JOptionPane.showMessageDialog.

m ToolTipText: texto explicativo exibido quando o mouse passa sobre 0

componente:



Salvar

Salvar oz Dados

m No Netbeans basta inserir o texto desejado na propriedade ToolTipText dos
Componetes (JLabel, JTextField, JButton ...).

JFileChooser

m Janelas de dialogo para selecao de arquivos:
m Abrir (Open)

m Salvar (Save)

=

Look in: ] Jv..vMB ~| =] [#] [=] [BREE
1 bodand =
] .jouilder?

[ netoeans

7 Armblente de impresséo
] Arbiente de rede

[ configuracies locais

[ Cookies
[ Dados de aplicatives -
—  File name: | | | Open
Files of type: | ANl Files (%) ~| | cancel |

Exemplo: Cdédigo a ser inserido na acdo de um botdo “Abrir Arquivo”:

JFileChooser arg= new JFileChooser();
int Result=arg.showOpenDialog(this);
if(Result==JFileChooser. APPROVE_OPTION){

File arquivo= arq.getSelectedFile(); //Classe para

Arquivos



System.out.printin(arquivo); /lImprime nome do

Arquivo

mClasse File: suporte para tratamento de arquivos:

m FileReader/FileWrite — FilelnputStream / FileOutputStream

sao usados para ler ou gravar arquivos no sistema:

FileReader in = new FileReader("Entrada.txt");

FileWriter out = new FileWriter ("Saida.txt");

mComando para ler e escrever arquivos (Byte e n&o String/char): read() e

write(String s)

while ((int c=arqin.read()) !'=-1){ // |é Entrada.txt
out.write(c); // grava em Saida.txt
System.out.write(c); // direciona para o video
}
out.write(p); // gravar a String no final do arquivo
in.close(); // fecha os arquivos

out.close();

}

e Exemplo: criar um programa que permita selecionar um arquivo de texto, “.txt”

e mostrar o conteddo em um JTextArea:



-> Crie uma nova Template, Java Gui Form - JFrame Form

HUTextMrea

| Abrir Arguno |

- Insira um JTextArea e um JButton, “Abrir Arquivo”, e dé um duplo clique no

bot&o, digite:

try{ // Blco de Tratamento de erros/excecdes nos arquivos
File arquivo; //Objeto para arquivos
JFileChooser arq= new JFileChooser(); // objetos de selecao de arquivo
int Result=arg.showOpenDialog(this); // mostra a janela de selecao de
arquivo
if(Result==JFileChooser. APPROVE_OPTION){ //verifica se foi seleciona
um arquivo
arquivo = arq.getSelectedFile(); //verifica o arquivo selecionado
int c; /Ilvariavel para receber os Bytes do arquivo
String Texto="";  //varidvel para receber os dados do arquivo
FileReader inArq = new FileReader(arquivo.getPath()); //abre o
arquivo para leitura
while((c = inArg.read())!=-1){  //Ié Byte por Byte até o final do
arquivo (-1)
Texto=Texto+(char)c; // transforma o Byte lido em um char
} /lfinal do while
jTextAreal.setText(Texto); // exibe no JTextArea o contetdo lido do

arquivo



inArg.close();
} // final do if
} catch (IOException ioe) { // verifica qual foi o erro/excecéo
JOptionPane.showMessageDialog(this,"erro ao abrir o arquivo"); //

mensagem de erro

}

- Insira, antes da declaracao da classe “public class”, no comeco do programa:
import java.io.*;

import javax.swing.*;

e E possivel acrescentar um outro botdo para salvar novos texto que o usuario

pode inserir no JTextArea:

- Acrescente um novo JButton “Salvar”, dé um duplo clique e digite:

try{
File arquivo;
JFileChooser arg= new JFileChooser();
int Result=arg.showSaveDialog(this);
if(Result==JFileChooser. APPROVE_OPTION){
arquivo = arq.getSelectedFile(); //Classe para Arquivos
FileWriter inArg = new FileWriter(arquivo.getPath());
inArg.write(jTextAreal.getText()); // 1&é o arquivo
inArg.close();
}
}catch(IOException ioe) {
JOptionPane.showMessageDialog(this,"erro ao abriri 0 arquivo");
} // Add your handling code here:



e Estes comandos podem ser inseridos em um Menu.

e A primeira aplicagédo criada como exemplo, representa a criacdo de editor de
texto ja composto de um Menu, mas que ndo possui 0s respectivos codigos
para efetuar as operagbes de abrir um documento e salva-lo. Experimente
implementar os respectivos cédigos nessa para efetivamente criar um editor de

texto.

JEditorPane

e Painel de Conteudo é uma area de texto especializada na exibicédo e edicdo de
varios tipos de conteudo: texto simples(text/plain), HTML(text/html) e RTF —
Rich Text Format(text/rtf).

e Exemplo: Criar um Programa que permita exibir um arquivo com extensao

“.html” ou “.htm”:

—> Crie uma nova Template Java GUI Form - JFrame Form

-> Insira um objeto JScrollPane no Form e insira dentro deste um objeto
JEditorPane, da Aba Swing (Other)

Selecionar Paging

-> Insira um objeto JButton, “Selecionar Pagina”:

JFileChooser arq = new JFileChooser();



int result=arq.showOpenDialog(this);
if(result==JFileChooser. APPROVE_OPTION){

try{
File arquivo= arq.getSelectedFile();

jEditorPanel.setPage(pagina);
} catch(MalformedURLException mue) {
JOptionPane.showMessageDialog(this,"Erro na pagina");
}catch( I0OException ioe){

JOptionPane.showMessageDialog(this,"Erro no arquivo");

—> Insira a importacdo dos pacotes, antes da declaracdo da classe “public class”
import javax.swing.*;
import java.net.*;

import java.io.*;

- Compile e Execute.


file:"+arquivo.getPath

8. Trabalhando Multiplos Formulérios - Menus.

m Assunto: Aplicagbes Graficas com Swing — Multiplos Formularios.

m Objetivo: Criar aplicacdes com Varios Formularios

SUMARIO
m Introducao
m Desenvolvimento:
o Criando Multiplos Formuléarios
m Conclusao

Criando Multiplos Formularios - Menus

m Para se construir uma Aplicacédo contendo varios Formuléarios € preciso cria-los
em separados e chama-los em um Formulario Principal através de Botbes ou de
Menus.

m No Formulario Principal a chamada dos outros formularios consiste em se criar
instancias dos respectivos formularios que se deseja exibir, utilizando o método
show(), ou o método setVisible(boolean).

m Na criacdo de Formularios utilizando o NetBeans ( e outras IDE), a ferramenta
cria os comandos necessérios para o fechamento do Formularios, desta forma se
o Formulario Principal chama-lo e este apdés, ser aberto, for fechado provocara o
fechamento da aplicacéo.

m Para evitar este “problema” devemos modificar “estes comandos” para podermos

fechar o formulério sem fechar a Aplicacéo.

Exemplo

» Criar uma Aplicagdo contendo um Menu que exibi os Formularios de Cadastro
de Clientes e de Veiculos




= Clique no Menu File > New - Java GUI Forms - Botdo Next > em Name
digite “SistLocacao” - Clique no Botao Finish

ps

Target Location

Choose Template

Target Location

Easic Class Definition
Create Fields

Orvertide Inherited Methoods
Crests Methodds

Marne: |Sis:tL0c:av;§0|

Target Location

G Filesystems

@ = C'Exemplos-Javailivro

@ = COExemplos-Java

@ = CExemploz-Java : MEB-IMNFiclasses

Falder: |

|

Directory: |C:1Exempl03-da'-.-'all_iw0

= Back

I

|| Cancel || Help |

= E preciso criar o Menu.

G Editing

[ Swing | Swing (Other) | awT | Beans | Layouts | Borders |
rbﬁuhl@@ﬁ—@_g:mg':'glzlﬁm@@gl

JMenuBar I:”

B Form SistLocagdo
& 7 Cther Components
@ T [JFrame]

m Na Aba Swing, clique no icone JMenuBar e cligue no Form - na Janela

Propriedades clique em Text

e digite “Cadastro” (texto que sera exibido pelo

Menu)-> Cligue com o botéo direito do mouse sobre o Menu criado - selecione

Add JMenultem - na janela propriedade clique em Text - digite Clientes -

cligue novamente com o botéo direito do mouse sobre o Menu criado - selecione

Add > JMenultem - clique em Text e digite Veiculos.



P EE  jMenuBar! [MMenuBar]

Menn

Everts k

Eclit Text

Cut Ctrl-x,
Copy Ctrl-C
Pazte Ctrl-wf

Rename...

Delete Dalete

Change Order ..
Miasee L

Miovee Coowvn

= = Goto Source

Properties
[ OutpoT FIncDw (SRS = T

0

JCheckBoxhenuttem
JRadioButtonkenutem
Jhvier

JSeparator

@ [ jMenud [MMenu]
|=| iWenutterd [Jhet

X2 1k ¢ ®

action riill
background [ [204 204
harder [MenutemBao
componentPopupikeny | =nohes
foreground W 000
IO il
MIFEManic

text =T

@| ||¢* AbreArguiva

m Observe que os SubMenus nao aparecem no Form este serdo exibido na

execucao do programa, mas apara o objeto criado no Form.

[ Layouts | Borders |
(] 5 e (] &= ]

Bl Form SistLocacsn

@ ™ [Frame]

@ N Other Components

@ FE  jMenuBart [IMenuBar]
@ 5 jMenul [Menu]
|=| iMenutterm [Jwiet

¥ Bl ke o=

@
background [ (204204
componertPopuphenu | =nones=
fort Dialog 1
for e oL W oo
([euly] FiLdll
MAEMORIC
test \Cliertes| /
toolTipText il

- Objeto IMenultem criado no
Form, o mesmo n&o aparece
no Form durante a construgéo
do programa. SO aparece na
Execucéo.

- Texto do submenu que
serd exibido para o usuério
na execugdo do programa.

- Se desgar modificar o
texto de um submenu, basta
clicar, na janela acima, no
objeto  desgado  (Ex:
jMenulteml) e na
propriedade Text digitar o
novo texto.




m Os Menus foram criados faltam os Formularios Clientes e Veiculos.

m Crie um Novo Form—->Clique no Menu File > New - clique no Botdo Next > em
Name digite Clientes - clique no bot&o Finish

m Modifique o Layout para AbsoluteLayout e insira trés JLabels para exibir o0s
rétulos “Nome”, “Fone”, “CPF” e trés JTextFields para podermos digitar/exibir os

dados.

Home |

Fone li

CPF | |

m Devemos modificar o comando responsavel pelo fechamento do Form, para que
nao feche a Aplicacao.

m Clique com o botdo direito do mouse no Form e cligue em “Goto Source” ou
presiione “Ctr-3”, procure o comando, que deve estar antes do método main:

“private void exitForm(java.awt.event.WindowEvent evt) {“

= Apague o comando:

System.exit(0);

m E digite no seu lugar:

setVisible(false);

m Volte para o primeiro Form (SistLocacéo), para isto clique na Aba SistLocacéao,

localizada na janela principal do Form



L B SistLocacdo * |

[E Output Wing SistLocaco Live - 1i0]

I

& Abres,

=

s Alaem

m Dé um duplo cligue em JMenultem1, se 0 mesmo néao estiver aparecendo clique

no menu criado, dé um duplo cligue no JMenulteml, para inserir 0o evento

responsavel pela chamada do Form Clientes.

K

kil [] [w] EH- &—

a—
Ch—

| Swing | Swing (Cther) | AWT | Beans | Layouts | Borders |

o E =[] e e

Menu

= Na janela de codigo que se abre, procure o seguinte comando:

“private void jMenultem1ActionPerformed”

= Antes deste comando digite:

@ = [Frame]
@ FE  jmenuBart [JMenuBar]

@ F jMenut [IMenu]

ir-.ﬂenurtem Jhiler

=1 iMenutem?2 [Jher
E;, BorderLayout

Clientes FormCliente = new Clientes(); //instancia¢g&éo do Formulario Clientes

m  Se tiver criado a Template com outro nome substitua o0 nome “Clientes” por

este nome.

m  E dentro do método, depois de “// Add your handling code here:”, digite:

FormCliente.show(); //exibicdo do Formulario Clientes

m  Compile e Execute.



Iz Window  Help

2o

o xf

}

SHE Exit
private 1

Soste

Repita 0s mesmos passos para criar o Form Veiculos e para exibi-lo.
Clique no Menu File > New > Next - digite 0 Nome “Veiculos” - clique

no botao Finish

Mude o Layout e insira os componentes (JLabel e JTextField), va para o

cbdigo e modifique o comando System.exit(0) para setVisible(false)

Volte para o Form SistLocacao e dé um duplo clique em JMenultem2,
antes do respectivo método actionPerformed instancie o Form:

Veiculos FormVeiculo = new Veiculos(); //instanciacdo do Form

m Dentro do método digite o comando para exibi¢ao:

FormVeiculo.show();

m  Compile e Execute. Seu Pequeno Sistema foi Criado



9. Applets — Funcionamento e Estrutura

m  Assunto: Applets: Funcionamento e Estrutura

m  Objetivo: escrever mini-aplicativos java que rodam na internet e intranet.

Applets

e S&0 pequenos programas Java que podem ser inseridos dentro de paginas
HTML.

e interagir com o usuario que a consulte

e pode executar tarefas complexas, como realizar célculos e apresentar

gréaficos, sons e imagens em movimento.

Applets: Funcionamento

e Para inserir uma applet numa pagina HTML, usamos a diretiva <applet>,
que deve apresentar pelo menos trés parametros: code, width e height.

Assim, a especificacdo mais simples tem a forma:

<applet code=[java applet] width=[largura] height=[altura]>
</applet>

e [java applet]: nome da classe principal do programa Java —
AloPessoal.class

e [largura] e [altura]:indicam a largura e a altura em pixels da area dentro da
pagina reservada para a apresentacao da applet.

e uma applet deve conter ao menos uma classe publica, e essa classe
publica deve estender a classe Applet.

e Aclasse Applet faz parte do package applet:




import java.awt.*; //importacdo dos componentes
import java.applet.*; /importacéo da classe Applet
public class AloPessoal extends Applet {
public void paint(Graphics g){ //método para desenho
g.drawString("Al6é Pessoal!", 100, 20); // desenha um texto

}

e Este programa deve ser compilado, e apdés a depuracdo dos erros €
informado o arquivo gerado: .class, no arquivo html através do parametro
code (code = ArquivoJava.class) é informado qual o arquivo Java a ser
utilizado na pagina HTML.

e Arquivo Html (com um nome qualquer, Ex: Alo.html):

<applet code= AloPessoal.class width=120 height=120>
</applet>

Egj; Applet ¥iewer: AppletaAloPessoal.class - I I:Ilil

Applet

Ald Peszoall

e Parametros adicionais:
0 codebase: URL do diretério que contém as classes compiladas
(bytecodes) do applet
o name: Um nome que identifica uma particular instancia de um applet
dentro de uma pagina HTML (Gtil para comunicacao entre applets).
o align: especifica um alinhamento para a area da applet dentro da

pagina. Analogo ao alinhamento de imagens.



o alt: Texto a ser exibido na area da applet durante o carregamento,

ou na impossibilidade de carregar a applet.

Applets: Estrutura

A classe Applet define quatro métodos basicos para controlar a
execucao e interacdo com o browser:

a) init(): executado quando a applet e carregada ou recarregada — adicao de
componentes, recebimento de parametros de execucao e preparo da applet
b) start(): executado apds o0 método init ou ao ser recarregada — deve ser utilizado
guando € necessario assegurar alguma condicao especial.
c) stop(): executada quando o usuario muda de pagina permanecendo na
memoria, ou fecha o browser.
d) destroy(): executada quando a applet for removida da memoria.
paint(), é definido pela classe Component da AWT: atualiza a exibicdo da applet

A maneira mais simples de se construir uma applet € por meio do
método paint — o contetido apresentado s6 depende desse método.

A combinacédo destes métodos representa o ciclo de vida de uma applet.

Criando Applets no NetBeans
A criacdo de Applet utilizando o Netbeans € uma tarefa simples,
devendo ser criado apenas o programa Java, o Applet, porque a ferramenta cria
automaticamente o corresponde arquivo HTML, com o mesmo nome do seu

programa, contendo os codigos para executar a pagina web.

1) Criar um Applet que permita ao usuario digitar dois niUmeros reais e mostrar o

resultado da soma destes:



m A criagcdo de Applet no Netbeans € feita através de Templates, € possivel
trabalhar com a Classe Applet do pacote AWT ou com a classe JApplet do pacote
Swing.

m O Exemplo que se segue, sera implementado utilizando o JApplet.

m Cliqgue no menu File > New - Java GUI Form —>JApplet Form - clique no

Botdo Next - digite 0 nome “Calculadora” e clique no botdo Finish.

1. Choose Template Select a Template:
2. [ FOioeT

[0 .Java Package
@ [Q Java Claszes
@ 3 Java GUIForms
Japplet Form
JDialog Form
JFrame Farm
JinternalFrame Farm
JPanel Form

E] BeanForm
© 3 AWT Forms
@ [0 Sample Forms

B

Template Description:

Uszing this template, you can design a new JFC (Swing) Applet.

An applet iz a Java clazs that can be run in any Jawva-enabled browser.

m Antes de inserir os componentes modifigue o Layout para “Nulll Layut”, para
poder organizar os componentes da maneira desejada. Clique com o botdo direito
do mouse, na janela no canto superior direito, em JApplet e selecione “Null

Layout”

”

m Insira trés JLabel (“Numero 1: ” e “Numero 2: “), dois JTextField, quatro

t 13 tE {1 Lt 11

JButton(“Somar”, “Diminuir”, “Multiplicar”, “Dividir”), organize-os da seguinte forma:



Nimero 1

Nimero 2

Somar Diminuir Multiplicar Dividir
Resultado:

[ b

| Em

Buttond [JButtor

¥ e R
fart

] =

Dialog 1=

faregraund

W [0,0,0]

icon

null

MNEMonic

text

toolTipText

[

m Para inserir um atalho para o botdo, digite a letra desejada na propriedade

“Mnemonic”
m A parte visual foi criada, falta os eventos dos botdes.

mDé um duplo clique botdo “Somar” e digite:

float opl,0p2, result; // varidveis auxiliares

/I"pega" o numero digitado e o converte para float
opl=Float.parseFloat(jTextField1l.getText());
op2=Float.parseFloat(jTextField2.getText());
result=opl+op2;

/lconverte o resultado em String e exibe
jLabel3.setText(String.valueOf("Resultado: " + result));
jTextFieldl.setText(" "); /ILimpar o JTextField
jTextField2.setText(" ");
jTextFieldl.requestFocus(); //muda o foco para o JTextField 1

m Compile e Execute.

m Observe que ao executar o programa o mesmo € mostrado no Applet Viewer,

um aplicativo do JDK construido para auxiliar na implementacdo dos applets, e

gera automaticamente o arquivo HTML com o0 mesmo nome do programa applet.



E"E,%Applel: Yiewer: Applets/ICalculadora - | I:Ilﬁl

Applet

MNimero 1

|
Mimero 2 li

Somar Dimninuir

Multiplicar Dividir

Resultado:

Applet started.

m Para visualisar o arquivo HTML, cliqgue no menu View—>FileSystem, e dé um

duplo cliqgue no arquivo com o mesmo nome do programa, mas do tipo HTML

Ij Filesystems
@ =2 COExemploz-Java
@ [0 AgencisBancaria
@ [0 aAgenda
© = Applets
@ [0 Calculadora
@ Calculacora
& B calculadora

Explorer [Filesystems] E
i

@ clock |HTr-.-1L File
o [B™ Clock
= Paing

@ Padina

@ Paszagem

Ly B osp e 2 S @ O
<HTHL*
<HEAD*
<TITLE=Applet HTML Page</TITLEx
< /HEAD >
<BODT*

<HZ==<HE WIDTH="100%"=Applet HTHML Page<HE WIDTH="100%"=</H3=

“p=

=APPLET codebase=.. code="Appletss/ICalculadora.class" width=b50 height=
<P

=HE WIDTH="100%"=<FONT E2IZE=-lr<I=Generated by NetBeans IDE=</I=</FONT=

m Se desejar modifique a area destinada a mostrar o applet no browser, modifique

no arquivo HTML os valores dos codigos WIDTH (Largura do Apllet) e HEIGHT(

Altura). Ex:



<APPLET codebase=.. code="Applets/JCalculadora.class” width=350
height=250>
</APPLET>

m Para executar o arquivo, ou seja, abrir no browser, basta executar (F6):

/Z} Applet HTML Page - Microsoft Internet Explorer

Fil= Edit ‘iewms Favorites Tools  Help

4= EBack -~ =p - @ b | @Search [5] Favorites @Media @ |E

Address @ hkkp: localhost: 3081 fappleksf I alculadora . html

Applet HIML Page

Hiimero 1 8545
Namero 2 41.75|

Somar | Diminuir Multiplicar Dividir

Resultado:

m Para implementar as opera¢cdes matematicas (eventos) dos outros botdes,
dé um duplo cligue no botédo e digite 0 mesmo cédigo do botdo soma e
modificando apenas o sinal de soma para a operacdo desejada. Exemplo
par ao botao “Subtrair”

float opl, op2, result; // variaveis auxiliares

/l "pega" o numero digitado e o converte para float
opl = Float.parseFloat( jTextField1.getText() );

op2 = Float.parseFloat( jTextField2.getText() );
result = opl- op2;

/lconverte o resultado em String e exibe



jLabel3.setText( String.valueOf( "Resultado: " + result) );
jTextFieldl.setText(" "); /ILimpar o JTextField
jTextField2.setText(" ");

jTextFieldl.requestFocus(); //muda o foco para o JTextField 1

m  Também é possivel exibir os resultados das operacdes utilizando um

JOptionPane.

2) Crie um Applet que informa o valor do empréstimo, que é calculado conforme o
valor do saldo médio digitado pelo usuario (até R$ 1000,00 -> zero, de R$ 1001
até 2500->30% do Saldo Médio, acima de R$ 2500-> 50% do Saldo Médio):

m Crie um Novo Programa: File->New—->Java GUI Form—->JApplet—>digite o
nome "Empréstimo” - Finish

m  Cligue com o Botdo direito do mouse no Form, selecione “setLayout” e
cligue em “Null Layout”.

m Insira dois JLabel no Form, modificando as propriedade “Text” para “Saldo
Médio” e “Valor do Empréstimo”, insira um JTextField e um JButton,

modifique a propriedade “Text” para “Calcular”.

| 1— J ULl Bl L R L el )

[#]  jButtont [JButton]
- st jLakel2 [JLakel]

¥ 2 v v &

NOFNZONTALANGNMENT | LEALINL
Saldo Médio -
icon riudll
S| labelFar =nones
Calcular |'q.-‘alur do Empréstimo: | text |"-.-"a|u:ur ] Empréstimu:u:|
toolTipText riudll
vertical Alignment CEMTER

1]

—‘ Propetties LOther Properties LEvents LLE':.-'I:IL
Code Generation L.&ccessibil'rty |

orias # | B Emprestimo =

m  Dé um duplo clique no botéo e digite os comandos:



float saldo; /Ivariavel auxiliar
try{ [ltratamento de erros do valores
saldo = Float.parseFloat(jTextField1l.getText()); //’pega” o valor digitado e
converte
/Iverificac&o dos valor digitado e do empreéstimo que pode ser concedido
if (saldo<1000)
jLabel2.setText("Valor do Empréstimo: Zero");
if ((saldo>=1000) & (saldo<=2500))
jLabel2.setText("Valor do Empréstimo: " + saldo * 0.3);
if (saldo>2500)
jLabel2.setText("Valor do Empréstimo: " + saldo * 0.5);
}catch (Exception e){ /lexibe mensagem caso ndo seja digitado um
valor valido

jLabel2.setText("N&o € um Valor Valido");

m  Compile e Execute.



10. Banco de Dados No NetBeans

¢ Assunto: Acessando Bancos de Dados.

* Objetivo: criar programas que acessam Banco de Dados.

Acessando Bancos de Dados

* A comunicacéo de cddigo Java puro com Banco de dados € uma tarefa
muito dificil, devido a enorme quantidade de bancos de dados, existente
no mercado, com linguagens proprietarias.

* A plataforma Java permite o acesso a banco de dados por meio de uma
API  (Application Programming Interface) chamada JDBC (Java
Database Connectivity).

e E uma interface entre a linguagem Java e outra linguagem que todos 0s
bancos de dados suportam.

* O Objetivo da JDBC ¢ possibilitar o uso de dados existentes em SGBDR
remotos. Utiliza o SQL (Structured Query Language), linguagem

destinada as operacdes dos SGBDR.

Arquitetura

E muito parecida com o padrdo ODBC (Open DataBase Connectivity).

A Aplicacdo para acessar um BD deve utilizar a APl JDBC, contida no

pacote java.sq|l.

Por meio da classe DriverManager, seleciona-se o driver de acesso ao BD
que serd utilizado.O driver passa a oferece uma interface padronizada para

a Aplicacao, implementando em Java ou de forma nativa o acesso ao BD.




N

w

Progratna Java
Gerenciador de Driver JDBC
Eﬂ‘f‘aﬂﬂ” nﬂulhﬂ 8 driver JDBC
. s;';fnffﬂﬁ[' | IDBC/ODBC
driver ODBC

\fl

Banco de Dados

l‘aPIJDE.I:

iAFI do driver JDBC

Instalacdo de uma fonte JDBC/ODBC em plataforma Windows:

. Acessar o painel de controle e ativar o aplicativo Fonte de Dados ODBC,;

. Clicar no botdo adicionar (DNS do usuario) para criar uma nova ponte de um

banco de dados;

. Selecionar Driver adequado (Driver do Microsoft Access, por exemplo)

. Preencher a caixa de didlogo com um nome para a Fonte de Dados do BD e a

localizag&o do servidor.

. Clicar no botéao “Selecionar” para definir o BD a ser usado.

Podemos construir uma aplicacdo usando o seguinte roteiro:

1°) Importar o pacote java.sql:

import java.sql.*;

2°) Carregar o driver de acesso ao BD : ( ponte JDBC-OBDC)



Class.forName(“sun.jdbc.odbc.JdbcObdcDriver”);

4°) Obter uma conex&o com o BD: (BD Access: |JPlanetas)
Connection conexao =

DriverManager.getConnection(“jdbc:odbc:1JPlanetas”);

5° Por meio da conexdo realizada, devemos obter uma instancia de um
objeto Statement, PreparedStatement ou CallableStatement, para passar
comandos SQL ao BD:

Statement stmt= conexao.createStatement();

6. Criar objetos para executar operagdes no BD (execute (String), executeQuery
(String), ExecuteUpdate(String), executeBatch()):

int reg =stmt.executeUpdate(“delete from planeta where nome="Maria’”);

ResultSet rs = stmt.executeQuery(“select nome from planeta”);

7. Algumas operacdes retornam resultados do BD (um objeto Resultset — conjunto

de registros), os quais devemos exibir ou processar:

while(rs.next() ) { /move o curso de registros
String Nome=rs.getString(“nome”); // obtém o valor do campo
‘nome” da tabela

System.out.printin(Nome);

}



8. Quando nao precisar mais dos objetos obtidos, libere-os:

rs.close();

stmt.close();

9. Apds todas as operacgdes encerre a conexao com BD:

conexdo.close();

* Exemplos de métodos de ResultSet:

rs.absolute(3); //move cursor para linha
rs.updateString("Nome”, "Maria”); //atualiza nome
rs.updateRow(): //atualiza linha na tabela
rs.moveTolnserRow(); //insere nova linha

rs.updatelnt(2, 3535); //atualiza coluna 2

Principais Comandos SOL

Segue exemplos dos principais comandos que serdo utilizando em uma

aplicagéo que realizar operagdes em um Banco de Dados:

Tabela

Brasil

idade Estado Pop Sit
Brasilia DF 2.000.000 Cheio

m SELECT: - realiza consultas

Select cidade, estado FROM Brasil WHERE pop > 1000;



m  INSERT: - Insere um registro

INSERT INTO Brasil (cidade, estado) VALUES ( Cid, Est)

m  UPDATE: - Modifica um registro

UPDATE Brasil SET Sit = “Cheio” WHERE Pop > 1000;

m  DELETE: - Excluir um registro

DELETE FROM Brasil WHERE cidade =“BSB”

Construcao de Aplicacdes - Acessando um Banco de Dados Access

Este exemplo realiza uma consulta na tabela denominada Relacao, com os
campos Nome e Id. Vamos partir do principio de que a “ponte” JDBC-OBDC ja foi
criada com o0 nome BDAccess.
import java.sql.*;  //pacote para trabalhar com BD
public class LeBDAccess{

public static void main(String args[]){

try{ //tratamento de erros

Usuario



Class.forName("sun.jdbc.odbc.JdbcOdbcDriver");//seleciona Driver

//lconecta com BD
Connection con=DriverManager.getConnection("jdbc:odbc:PBD-

NOmeS“,””,““);

/lobjeto comandos SQL Senha

Statement stmt= con.createStatement();

//[Comando SQL

ResultSet rs=stmt.executeQuery("select * from Relacao");

/Iverifica se existem registros

while(rs.next()){

I/l obtém o valor armazenado no campo “Nome” da tabela
Relacao

String nome=rs.getString("nome");

// obtém o valor argmazenado no campo da Id
int id=rs.getInt("id");

/[ imprime o conteldo da variavel
System.out.printin("Nome:"+nome+ " Ident:"+id);

}

rs.close(); //fecha "ponte”

con.close(); //fecha conexdo com BD

} catch(SQLException e){ //trata os erros
System.out.printin(“erro de conexao’+ e.getMessage()); //

mensagem de erro



} catch(ClassNotFoundException e){

System.out.printin("Driver ndo encontrado™);

}

JDBC no NetBeans

O NetBeans nao possui ferramentas que permitam criar visualmente
componentes, em um programa, para manipular os dados de uma tabela, a
exemplo dos existentes em outras ferramentas, em outras Linguagens de
programacao.

Para trabalhar com Banco de Dados é preciso fazé-lo via codigo, que
devera ser inserido dentro do método “actionPerformed” de um JButton.

Cria-se o0 “Formulario” contendo 0s componentes visuais para
mostrar, e manipular, os dados da tabela do Banco de Dados. Dentre estes
componentes estdo os botdes ou menus, 0S quais Serdo 0S responsaveis por
executar os codigos para realizar uma determinada operacao, consulta, insercéo,
alteracéo ou exclusdo em um BD.

Depois de criada a “parte visual’, devem ser implementados os

codigos nos botdes/menus:

OBS: - Os exemplos que se seguem utilizam uma Fonte de Dados ODBC com o
Nome: “PBD_Nomes” que representa uma conexdao com um Banco de Dados
Access, contendo uma Tabela com o nome: “TabFicha”, contendo os campos
(Matricula — Tipo Numero/Chave Primaria; Nome — Tipo Texto)

- Parte Visual do Programa:
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a) Cédigos para Inserir:
try{ //tratamento de erros
Class.forName("sun.jdbc.odbc.JdbcOdbcDriver");//busca Driver
/lconecta no BD
Connection con = DriverManager.getConnection("jdbc:odbc:PBD-
Nomesll’llll,llll);
Statement stmt = con.createStatement(); /lobjeto comdo sq|

String CadNome = jTextField1.getText(); //obtém nome digitado

int CadMat=Integer.parselnt( jTextField2.getText() );

stmt.executeUpdate(“insert into TabFicha (Matricula, Nome) values (" " +
CadMat +"''" +

CadNome + "")");
JOptionPane.showMessageDialog( this, " Dados Salvos! ");
con.close(); // fecha conexdo com BD
} catch( SQLException e){ //trata os erros
JOptionPane.showMessageDialog(this, "Erro Cmdo SQL " +

e.getMessage() );



} catch( ClassNotFoundException e){

JOptionPane.showMessageDialog( this, " Driver ndo encontrado " );

b) Codigos para Consultar gue devem ser inseridos em um JButton/Menu:

boolean consulta=true; //variavel auxiliar utilizada para informar se houve sucesso
na consulta

try{ //tratamento de erros
Class.forName("sun.jdbc.odbc.JdbcOdbcDriver");//busca Driver
//lconecta no BD

Connection con=DriverManager.getConnection("jdbc:odbc:PBD-
Nomesll’"ll,llll).

Statement stmt= con.createStatement();//objeto comdo sql
String ConsNome= jTextField1l.getText();
ResultSet RS= stmt.executeQuery(
"Select * from TabFicha where nome=""+ ConsNome +""'");
while (RS.next(){
int Mat= RS.getInt("Matricula");
jTextField2.setText(String.valueOf(“Matricula”));
jTextField3.setText(RS.getString("Nome"));
consulta=false;
JOptionPane.showMessageDialog(this,"Dados Encontrados!");
}

if (consulta) JOptionPane.showMessageDialog(this,"Dados Nao
Encontrados!");

RS.close ();
stmt.close();
con.close(); //fecha conexao com BD

} catch(SQLEXxception e){ //trata os erros



JOptionPane.showMessageDialog(this,"Erro Cmdo SQL
"+e.getMessage());

} catch(ClassNotFoundException e){

JOptionPane.showMessageDialog(this,"Driver ndo encontrado");

}

c) Codigos para Alterar:

try{ //tratamento de erros
Class.forName("sun.jdbc.odbc.JdbcOdbcDriver");//busca Driver
/[conecta no BD
Connection con=DriverManager.getConnection("jdbc:odbc:PBD-
Nomes","","");
Statement stmt= con.createStatement();//objeto comdo sq|
String ConsNome= jTextField1.getText();
int CadMat=Integer.parselnt(jTextField2.getText());
String CadNome=jTextField3.getText();
int registro = stmt.executeUpdate("
update TabFicha set Nome="" +CadNome+ "', Matricula="
"+CadMat+ " 'where Nome=""+ ConsNome +"'");
if (registro!=0) JOptionPane.showMessageDialog(this,"Dados Alterados!");
else JOptionPane.showMessageDialog(this,"Dados N&o Alterados!");
stmt.close();
con.close(); //fecha conexdo com BD
} catch(SQLException e){ //trata os erros
JOptionPane.showMessageDialog(this,"Erro Cmdo SQL
"+e.getMessage());
} catch(ClassNotFoundException e){

JOptionPane.showMessageDialog(this,"Driver ndo encontrado");

}



d) Cadigos para Excluir:

try{ //tratamento de erros
Class.forName("sun.jdbc.odbc.JdbcOdbcDriver");//busca Driver
//lconecta no BD

Connection con=DriverManager.getConnection("jdbc:odbc:PBD-

NomeS"’""’"");
Statement stmt= con.createStatement();//objeto comdo sq|l

String ExcNome= jTextField1.getText();

int registro=stmt.executeUpdate("delete from TabFicha where Nome="" +

ExcNome +"'");
if (registro!=0) JOptionPane.showMessageDialog(this,"Dados Excluidos!");

else JOptionPane.showMessageDialog(this,"Dados nao

Excluidos!");
stmt.close();

con.close(); //fecha conexdo com BD



} catch(SQLEXxception e){ //trata os erros

JOptionPane.showMessageDialog(this,"Erro Cmdo SQL

"+e.getMessage());
} catch(ClassNotFoundException e){

JOptionPane.showMessageDialog(this,"Driver ndo encontrado");

NOTA:*****Antes de inserir os cOdigos é preciso importar os pacotes para
trabalhar com Banco de Dados e exibir caixa de mensagens:
—> Localize o codigo de criagdo da classe. Ex:
Public Class ...
- Antes deste comando insira 0s seguintes cédigos:
import java.sql.*;
import javax.swing.*;
Exemplo Completo
m Crie uma aplicacéo para cadastrar a Matricula e os Nomes dos

Funcionarios de uma Empresa.

1. Cligue no Menu File > New - Selecione Java GUI Forms - JFrame
Forms-> clique no botdo Next. Na janela que se abre, no campo Name,

digite “SistCadFunc” e clique no Botéo Finish.

2. Modifique o Layout do JFrame para AbsoluteLayout e insira os seguintes
componentes: dois JLabel (Nome e Matricula), dois JTextField e um
JButton (Salvar)
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3. A parte visual esta construida, falta o codigo para salvar os dados.

4. Abra o Access e crie um BD (BDCadastro) com uma Tabela (TabFicha)
com os campos: Matricula (Tipo Numérico/Chave Primaria) e Nome — Tipo

Texto.

5. Devemos criar a “Ponte” JDBC/ODBC: abra o Painel de Controle -
Ferramentas Administrativas—> Fontes de Dados ODBC-> clique no Botéao
Add - Selecione o Driver p/ BD Access > clique no botdo Concluir > no
campo “Nome da Fonte de Dados” digite “PBD-Nomes” - clique no botéo
Selecionar - Procure o BD criado (BDCadastro) e cligue no Botdo OK
->0K 2> OK
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6. Criado o BD e a Ponte ODBC, volte para a sua aplicacdo no NetBeans e
dé um duplo clique no JButton (Salvar) para codificar a conexao:
Depois de “private void jButtonlActionPerformed(java.awt.event.ActionEvent

evt) {“, digite:

try{ //tratamento de erros
Class.forName("sun.jdbc.odbc.JdbcOdbcDriver");//busca Driver

/Iconecta no BD

Connection con = DriverManager.getConnection("jdbc:odbc:PBD-
Nomesll’"ll,llll);
Statement stmt = con.createStatement(); //objeto comdo sq| Aspas Simples e

String CadNome = jTextField1.getText(); //obtém nome digitado
int CadMat=Integer.parselnt( jTextField2.getText() );

Aspas Duplas

f




stmt.executeUpdate(“insert into TabFicha (Matricula,Nome) values (" +

CadMat + ™, + CadNome + ™)");

JOptionPane.showMessageDialog( this, " Dados Salvos! "); ﬁig: gtrjlﬁ)rl)?:se
con.close(); // fecha conexdo com BD
} catch( SQLException e){ //trata os erros
JOptionPane.showMessageDialog(this, "Erro Cmdo SQL " +

e.getMessage() );
} catch( ClassNotFoundException e){
JOptionPane.showMessageDialog( this, " Driver ndo encontrado " );

7. Compile Execute.

8. Realizando operacdes de Consulta, Alteracéo e Exclusdo em BD:

Insira trés Botdes para executar as operagdes restantes no Banco de
Dados (Consulta, Alteracdo e Excluséo), um JLabel, para exibir o Texto “Nome
para Consulta/Excluséo”, supondo que estas operacdes serdo feitas através do
campo “Nome”, e insira tabém um JTextField para p usuario poder digitar o
“Nome”, ou crie um novo Form contendo os JLabel, JTextField , e JButton, sendo
gue o mesmo devera ser chamado por outro Form através de um JMenurBar.

Supondo que foram inseridos 0s novos componentes da seguinte forma:
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Basta dar um duplo clique no botdo desejado e inserir o respectivo cédigo

para a respectiva operagao:

Consultar

boolean consulta=true;

try{ //tratamento de erros

Class.forName("sun.jdbc.odbc.JdbcOdbcDriver");//busca Driver

/lconecta no BD

Connection con=DriverManager.getConnection("jdbc:odbc:PBD-

Nomes","","");

Statement stmt= con.createStatement();//objeto comdo sq|

String ConsNome= jTextField1.getText();

Aspas Simples
/ e Aspas Duplas

ResultSet RS= stmt.executeQuery("Select * from TabFicha where nome="" +

ConsNome + " ");
while (RS.next()){

int Mat= RS.getInt("Matricula™);
jTextField2.setText(String.valueOf(Mat));
jTextField3.setText(RS.getString("Nome"));

_/

AspasDuplase
Aspas Simples




consulta=false;
JOptionPane.showMessageDialog(this,"Dados Encontrados!");
}
if (consulta) JOptionPane.showMessageDialog(this,"Dados N&o
Encontrados!");
RS.close ();
stmt.close();
con.close(); //fecha conexdo com BD
} catch(SQLEXxception e){ //trata os erros
JOptionPane.showMessageDialog(this,"Erro Cmdo SQL
"+e.getMessage());
} catch(ClassNotFoundException e){
JOptionPane.showMessageDialog(this,"Driver ndo encontrado");

}

Alterar:

try{ /tratamento de erros
Class.forName("sun.jdbc.odbc.JdbcOdbcDriver");//busca Driver
//lconecta no BD
Connection con=DriverManager.getConnection("jdbc:odbc:PBD-
Nomes","","");
Statement stmt= con.createStatement();//objeto comdo sq|
String ConsNome= jTextField1.getText();
int CadMat=Integer.parseint(jTextField2.getText());
String CadNome=jTextField3.getText();
int registro = stmt.executeUpdate("update TabFicha set Nome=""+CadNome+
", Matricula=""+CadMat+ "where Nome=""+ ConsNome + " ");
if (registro!=0) JOptionPane.showMessageDialog(this,"Dados Alterados!");
else JOptionPane.showMessageDialog(this,"Dados N&o Alterados!");
stmt.close();



con.close(); //fecha conexdo com BD
} catch(SQLEXxception e){ //trata os erros
JOptionPane.showMessageDialog(this,"Erro Cmdo SQL
"t+e.getMessage());
} catch(ClassNotFoundException e){

JOptionPane.showMessageDialog(this,"Driver ndo encontrado");

}

Excluir:

try{ //tratamento de erros
Class.forName("sun.jdbc.odbc.JdbcOdbcDriver");//busca Driver
/lconecta no BD
Connection con=DriverManager.getConnection("jdbc:odbc:PBD-
Nomes","","");
Statement stmt= con.createStatement();//objeto comdo sql
String ExcNome= jTextField1.getText();
int registro=stmt.executeUpdate("delete from TabFicha where Nome="" +
ExcNome +"");
if (registro!=0)
JOptionPane.showMessageDialog(this,"Dados Excluidos!");
else
JOptionPane.showMessageDialog(this,"Dados ndao Excluidos!");
stmt.close();
con.close(); //fecha conexdo com BD
} catch(SQLEXxception e){ //trata os erros
JOptionPane.showMessageDialog(this,"Erro Cmdo SQL
"+e.getMessage());
} catch(ClassNotFoundException e){

JOptionPane.showMessageDialog(this,"Driver ndo encontrado”);

}



9. Compile Execute.

OBS: Como os comando de conexdo com o Banco de Dados estao se repetido,
0S mesmos poderiam ser implementados dentro de uma funcdo e serem
executados através de uma chamada desta funcédo quando se desejar estabelecer
uma conexao com o banco de dados para realizar uma determinada operacao em
suas tabelas, diminuindo a quantidade de cdodigo a ser digitado.
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